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About This Document  

This manual introduces the hardware components of NVR3000 series and 

describes how to install  them. It also provides an overview of Server surveillance 

functionality , and includes the functions  of Video Management Software for 

operat ing and monitor ing a Server network . 
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Disclaimer  
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Safety Precautions  

Electric Shock Warning  

This equipment may cause electric shocks if not handled properly.  

Â Access to this equipment should only be granted to trained operators 
and maintenance personnel who have been instructed of, and fully 
understand the possible hazardous conditions and the consequences of 
accessing non-field -serviceable units such as the power supplies.  

Â The system must be unplugged before moving, or in the even that it  
becomes damaged.  

 

 Reliable Grounding  

Particular attention should be given to prepare reliable grounding for the 
power supply connection. It is suggested to use a direct connection to the 
branch circuit. Check for proper grounding before powering on the device.  

 

Overloading Protection  

The device should be installed according to specifications. Provide a suitable 
power source with electrical overload protection. Do not overload the AC 
supply branch circuit that provides power to the device.  

 

ESD Precautions  

Please observe all conventional anti -ESD methods while handling the device. 
The use of a grounded wrist strap and an anti -static work pad are 
recommended. Avoid dust and debris in your work area.  
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Energy Hazards Precaution  

The device should be installed according to specifications. This device should 

be operated at a site that is:  

This equipment is intended to be used in Restrict Access Location, like 

computer room. The access can only be gained by SERVICE PERSONS or by 

USERS who have been instructed about the metal chassis of the equipment is 

have energy hazards that service persons have to pay special attention or 

take special protection before touching it. Further, the access is through the 

use of key or security identity system. Only aut horized by well trained 

professional person can access the restrict access location.  
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Device Installation/ Site Selection  

The device should be installed according to specifications. This device 

should be operated at a site that is:  

Â Clean, dry, and free of excessive airborne particles.  

Â Well-ventilated and away from heat sources such as direct sunlight 

and radiators.  

Â Clear of vibration or physical shock.  

Â Away from strong electromagnetic fields produced by other devices.  

Â Available with properly grounded wa ll outlet for power. In regions 

where power sources are unstable, apply surge suppression.  

Â Available with sufficient space behind the device for cabling.  

Never install or use, unless waterproof or dust -resistant is listed as a 

feature,  the device in the following locations:  

Â Areas where chemicals are used. 

Â Areas where dust, debris, or pollen is in excess.  

Â Areas where corrosive gas, sea water or high humidity is present.  

Â Areas where steam vapor or flammable environments is generated.  

Â Areas where radiation,  X-rays, strong electric waves, or magnetism is 

generated.  

Â Areas outside of the allowable ambient operating temperature range.  

Â Areas subject to impact or rigorous vibration . 



 

 20 

Chapter 1. Product Overview  

1.1 Features and Benefits  
The NVR3000 series is a state-of-the-art network video recorder features RAID, low 

power. With bay hard disk trays, the NVR3000 series is the best in class NVR that 

supports megapixel quality video of 4 to 64 channels for video retention periods 

from 7 to 40 days or more. In addition, the NVR3000 series is fully burn -in-tested 

and uses preloaded Enterprise VMS to eliminate compatibility issues while reducing 

maintenance overheads. It is out of question that the NVR3000 series is the most 

reliable and cost -effective solution for small to medium sized surveillance needs.  
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1.2 Specifications for the NVR3000 Series  

1.2.1 Hardware Specifications   

 NVR3104 Series NVR3308 Series 

System Processor Intel Celeron Dual Core 1.8GHz 

NVR3308E1: 

Intel Core i3 Dual Core 3.3GHz 

NVR3308A1: 

Intel Core i7 Quad Core 3.4GHz 

System Memory DDR3 2GB (up to 4GB) DDR3 4GB (up to 16GB) 

Operating System  Linux Embedded System 

Storage 4 x 3.5" SATAII/SATAIII  

hard disk drives

8 x 3.5" SATAII/SATAIII  

hard disk drives 

I/O Interface   ̧ RJ-45: 1x Gigabit Ethernet  
 ̧ USB: 6x USB2.0 
 ̧ VGA(DVI): x1, HDMI: x1, DVI-D x1 

 ̧ RJ-45: 2x Gigabit Ethernet  

 ̧ USB: 8x USB2.0 

 ̧ VGA: x1, HDMI: x1 

RAID Non-RAID, 1, 5, 6

Electrical   ̧ Input Voltage: 100-240 V 
 ̧ Power Supply: 250W 

 ̧ Input Voltage: 100-240 V, 3.5A 
 ̧ Power Supply: 250W 

Operating Environment Temperature:  5ǯ C to 40ǯ C 

Humidity:  5% to 80% (non-condensing) 

LED Indicator Yes (HDD) 

Dimensions (mm) 88(H) x 430(W) x 390(D) mm 

Weight  
(without hard drives)  

Ò9kg (without HDD) 

Certificate  UL, CB, FCC/CE Class A 

Warranty 2 years 

 



 

 22 

1.2.2 VMS Specifications 

Live View Å Real-time network camera discovery  
Å Versatile views of various screen divisions 
Å Multiple views supported 
Å View patrolling for single or multiple views  
Å Real time video/event alarm display  
Å Support 3 installation modes and 5 different fisheye 
Dewarp display modes  
Å Support live audio 

eMAP Å Drag-n-drop camera manipulation  
Å Hierarchical and multiple layer map structure  Å  
Å Real time event alert  
Å Instant live video of camera  

PTZ Å Pan, tilt, zoom operations (depend s on camera) 
Å Built-in, floating PTZ control panel  
Å Preset position (dependent of the camera) 
Å Event-driven camera patrolling  
Å Support On-screen PTZ 

I/O  Å Digital I/O management  
Å Support Ethernet Digital I/O controller  

Multiple Displays Å Support dual monitors  
Å Supports live view, playback, eMap functions  (depends 
on product)  
Å Direct display to secondary monitor(s)  

Investigation  Å Search by date, time and camera 
Å Search by VI event combinations  
Å Search over multiple days 
Å Search over multiple cameras 
Å Different colored recording indicator on calendar  
Å Search via built-in VI analyzer 
Å Intuitive, video thumbnail search results 
Å Cue-in, cue -out and loop playback 
Å Quick playback by video thumbnail 
Å 1/8, 1/4, 1/2, 1x, 2x, 4x, 8x play, pause, stop 
Å AVI-format ted video clip export  
Å Up to 16 channel synchronized playback (depends on 
product)  
Å Support 3 installation modes and 5 d ifferent Fisheye  

Dewarp playback display modes 

Video Intelligence  Å General motion detection 
Å Camera motion detection  
Å Missing object detection 
Å Foreign object detection 
Å Intrusion detection 
Å Forbidden area detection 
Å Tampering detection 
Å Virtual Fence 
Å Object Counting  (configure on remote client)  
Å Go in/out detection (configure on remote client)  
Å Tailgating detection (configure on remote client) 

Recording Policy Å Supports up to 96 channels megapixel recording 
(depends on product)  
Å Continuous recording  
Å Event-driven recording along with rules  
Å Scheduled recording on daily or weekday basis 
Å Post alarm recording 1-300 seconds 
Å Pre-alarm recording 1-300 seconds 
Å Support individual schedule recording 
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Rule Manager Å Conditional recording/alert/notification  
Å Email, FTP, SMS, popup window, PTZ,VI Panel, Relay 

output notifications  
Å Sound, alarm, round-the-clock alerts  
Å Support email template 

Remote Management Å Remote operation & management via  VMS Client 
Å Remote management and control via SCC & SCC Client  

Remote Client Å Web Client 
Å iPhone Client  
Å Android Client  

3rd Party IPCAM Å ACTi, Arecont Vision, Axis, Dahua, Dynacolor, Hikvision, 
IQinvision, Mobotix, Panasonic, and more 

Storage Expansion Å Built -in RAID storage management 
Å Recording to iSCSI/NAS  
Å Backup to iSCSI/NAS 

General & Misc Å Video privacy mask 
Å Digital zoom in, zoom out 
Å Log viewer, log export mechanism  
Å Client auto login 
Å Automatic storage recycling 
Å Client-server architecture  
Å Customized authority account management  
Å Digital watermark proofing  
Å Support DDNS Function 
Å Support t ime sync with NTP time server  
Å Provide System and VI setup Help assistance 
Å Support Customized Event Management and log 
mechanism 
Å Auto port mapping for internet connection  
Å Support batch setting IPCAM parameters  
Å Support Health Check function  
Å Support standby recording (Failover)  
Å Support offline recording with Surveon cameras 

Language Support multiple language on VMS including English, 
Czech, Dutch, French, German, Italian, Japanese, Korean, 
Persian, Polski, Portuguese, Russian, Slovak, Spanish, 
Turkish, Simplified Chinese, Traditional Chinese  
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Chapter 2. Hardware Overview  

2.1 Front Panel  

  

  

  

 

 

 

 

 

 

 

 

 Function  

1. Power Button  Powers up the NVR3000 Series. 

2. HDD Status Indicator  Indicates the hard disc drive status.  

3. Front USB Connector  Connects external accessories such as mouse, keyboard 

or other external device s. 
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2.2. Rear Panel  

NVR3104 Series 

 

 

  

  

  

 

 

 

 

 

 

NVR3308 Series 

 

 

 

 

 

 

 

 

  



 

 26 

 

 Function  

1. Power Socket  Used for connecting power cable.  

2. Power Switch  The power switch on 8000U system can be located on the rear 

panel.  

3. Serial Port  A COM port used for connecting various devices, such as a 

mouse, modem, network, printer and so on.  4. Serial Port  

5. HDMI Port Used for connecting audio/video  devices such as video 

projectors and DVD players. 

6. DVI-D Port Used for attaching an external digital monitor  to the NVR3000 

Series. 

7. VGA Port  Used for attaching an external monitor  to the NVR3000 Series. 

8. LAN Port   
(GbE Ethernet port )  

Used for connecting the NVR3000 Series with the network . Note 

that for single LAN Mode, use LAN1 

9. USB Port x 2 Used for exporting video clips as evidence support to external 

storage devices. 

10. PS/2KB/MS Port Used for connecting a keyboard and a mouse. 

11. USB Port x 2 Used for exporting video clips as evidence support to external 

storage devices. 

12. Line -In 
      Line -Out 
      Mic-In 

Used for audio in/out and microphone in.  

13. USB Port x 2 Used for exporting video clips as evidence support to external 

storage devices. 

14. Fans Used of cooling the device  
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2.3. Hard Drive Designation  
Hard disk drives are purchased separately. When selecting hard disk drives 

(HDD), HDD manufacturers always urge users to choose enterprise/surveillance 

grade drives for 24/7 surveillance operations  to ensure system stability. The 

surveillance hard drives on our Approved Vendor List (AVL) are engineered to 

work continuously, withstand high -temperature fluctuations and equipment 

vibrations found in any typical surveillance application. To reduce errors 

occurred on your RAID data and the chance of the recording performance being 

affected, it is highly recommended to use HDDs listed on our Approved Vendor 

List (AVL) to ensure reliability.  

Find the AVL on our web page: http://www.surveon.com/support/hardware.asp  

 

The hard drive  arrangement for each system is shown below. The general 

alignment is from left to right and / or  top to bottom in numeric order.  

Install the HDDs onto the bracket(s) and secure them with screws  supplied.  

For an easier cable connection, the HDD should be situated upside down , so that 

the connectors can be seen as indicated below.  

Be sure to install the HDDs according to the set order  as the indication shown.  

Note:  For the 4-Bay product, NVR3104 Series, there is only 1 HDD bracket.  

For the 8-Bay product, NVR3308 Series, there are 2 layers of HDD brackets.  

 

  

 

 

 

http://www.surveon.com/support/hardware.asp
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Chapter 3. Software Overview  

3.1. Software Introduction  
Video Management Software (VMS) is a highly modular and powerful video and 

hardware management suite that incorporates Server recording, management, 

and video monitoring and playback functionalities to serve the core purposes of 

a video surveillance system.  

It operates in a client -server mode: The Local Client  and Local Domain Server 

run for  standalone SMR/NVR/VMS Server, while the Remote Client receives live 

video streams and event video playbacks from LAN or Internet . All 

administrative tasks are perform ed on the Client. The client software provides 

the ability to monitoring and playback recorded videos from multiple cameras.  

And for users having multiple SMR/NVR/VMS Servers, Surveon Control Center 

(SCC) (its main functions are the same with the VMS) can be utilized to manage 

over the domain infrastructure.   
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3.2. Module Framework  
Â VMS/NVR Server  

¶ Combines video recording, archival and retrieval functionalities for 

individual server s/standalone PCs. 

¶ Serves as the connection point for client stations.  

Â Local Domain Server 

¶ The interface between the VMS/VI Servers and any clients.  

¶ User authentication server.  

Â Local Client 

¶ Local access, VMS Client installed on standalone PCs/NVRs for live 

video monitoring, event recording playback access and VMS system 

configuration.  

Â Remote Client (full functions)  

¶ Remote access, VMS Client installed on remote PCs for live video 

monitoring, event recording playback access. 

¶ Serves as the default configuration point for NVR2000  series, which 

do not have a Local Client.  

Â Web Client (for simple use)  

¶ Remote access, an ActiveX application (OCX) installed on remote PCs 

for live viewing and event playbacks through the web browser.  

Â SPhone Client (for simple use)  

¶ SPhone Client installed on iOS/ Android devices for basic live viewing . 

Â Web Server 

¶ Allows user to access the live video stream, PTZ control and event 

recording playbacks through Microsoft Internet Explorer 7.0 (or 

higher) after the Web Clients components are downloaded.  

Â VI Server 

¶ The video intelligence processing point for a VMS solution.  

¶ Preinstall ed on SMR/NVR Server, and optional on a separate 

server/PC (VMS). 

Â SCC Domain Server 

¶ Allows centralized control over multiple Trusted VMS Server points 

and connections from multiple clie nts.  

Â SCC Client  
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¶ Software capable of accessing multiple Trusted VMS Servers through 

the SCC Domain Server 
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3.3.  System Architecture  
VMS operates in scalable client - server architecture . This architecture  can be 

divided into three types: (1) Standalone Server (2) Standalone Server + Remote 

Client (Web Client/ SPhone Client) (3) Multiple Servers + SCC Client.  

These are the hardware requirements for using PCs as Server or Client. 

 

VMS Server + Client  

Support 
NVRs 

Ó 32CH 16~32CH Ò 16CH 

OS 
64-bit :  

Windows 7 Professional, Enterprise, Ultimate  

CPU 
Intel Core i7-980X or 

above 
Intel Core i7-860 

or above 
Intel Core i 5-650 

or above 

Memory 4 GB or above 

Display nVidia GeForce GTX660 2GB or above 

Hard 
Drive 

SATA 7200 RPM, 500 GB or above 

Network 1 Gbps or above 

Remote Client  

OS 
64-bit :  

Windows 7 Professional, Enterprise, Ultimate  

CPU 
Intel Core i7-980X 

or above 
Intel Core i7-860 

or above 
Intel Core i 5-650 

or above 

Memory 4 GB or above 

Display nVidia GeForce GTX660 2GB or above 

Hard 
Drive 

SATA 7200 RPM, 500 GB or above 

Network 1 Gbps or above 

VMS Server Only 

OS 
64-bit :  

Windows 7 Professional, Enterprise, Ultimate  

CPU Intel Core i 3-530 or above 

Memory 4 GB or above 

Display On board (generic) 256MB or above 

Hard 
Drive 

SATA 7200 RPM, 500 GB or above 

Network 1 Gbps or above 
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3.3.1. Standalone Server (Client -Server All -in -One) 

For users with standalone Server, the Local Client UI is used to manage NVR 

Server services: 

 

ʆ Application:  

The Server, IP cameras are all in the same LAN. 

 

Use NVR as Server 

No installation needed.  

Use PC as Server 

Install both the VMS/NVR Server and VMS Client on a PC:  

j Insert the VMS/IPCAM product CD.  

k Click VMS Suite on the menu to start the installation.  

l Choose Typical Setup. If you donõt need video analytic functions, Advanced 

Setup can be selected to uncheck the VI Server.  
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3.3.2.  Standalone Server + Remote Client  (Web 
Client  /  SPhone Client ) 

For remote users to connect to SMR/NVR Server, a remote access, VMS Client 

installed  on remote PCs is needed for live video monitoring, event recording 

playback access.  

Also, the Web Client, an ActiveX application (OCX) can be used for basic live 

viewing and event playbacks through the web browser, while SPhone Client 

can be used for basic live viewing on iPhone /Android devices . 

 

Application1: Internet  

The Server, IP cameras and the PC/ Mobiles are all in the same LAN. 
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[NVR Server]  

Use SMR/NVR as Server 

No installation needed.  

 

Use PC as Server 

Install the VMS/NVR Server on a PC:  

j Insert the VMS/IPCAM product CD.  

k Click VMS Suite on the menu to start the installation.  

l Choose Advanced Setup to uncheck the VMS Client.  

If you donõt need video analytic functions, the VI Server can also be 

unchecked. 

 

Install the Web Server on the PC: 

j Insert the VMS/IPCAM product CD.  

k Click Browse CD/DVD in the menu.  

l Double click WebServerSetup .exe to start the installation .  

 

[Client ]  

Install the VMS Client on PCs: 

j Insert the NVR/SMR product CD.  

k Click VMS Client on the menu to start the installation.  

 

Install the Web Client on t he PCs (Optional):  

Launch Microsoft Internet Explorer 7.0 (or above) and enter your VMS Server IP 

address + ò/webclient ó in your web browserõs URL location, eg. 

http://172 .18.6.9/webclient  to download the Web Client application.  

 

Install the SPhone Client (Optional):  

Download the SPhone Client from App Store on the iPhone desktop.  

 

Install the SPhone Client (Optional)  

Download the SPhone Client from App Store on the Andr oid phone desktop.  

Note:  Please refer to Installing the VMS and Installing the Web Client for details.  

http://172.18.6.9/webclient
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Application 2: Internet  

The Server, some of the IP cameras and the PC are all in the same LAN, while 

the other  IP cameras are installed in remote location with Public IP.  

 

 

3.3.3. Multiple Servers + SCC Client  

For users with multiple SMR/NVR Servers, SCC Client UI is used to manage over 

the domain infrastructure.  
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Application 3: Internet  

(1) The Servers, IP cameras and the PCs are in LAN A. 

(2) Some IP cameras are installed in LAN B, which is behind a different router 

in a remote location.  

(3) Users are allowed to connect the SMRs/NVRs from remote PC over the 

Internet.  

 

 

[NVR Server]  

Use SMR/NVR as Server 

No installation needed. 

 

Use PC as Server 

Install the VMS/NVR Servers on PCs:  

j Insert the VMS/IPCAM product CD.  

k Click VMS Suite on the menu to start the installation.  

l Choose Advanced Setup to uncheck the VMS Client.  

The VI Server can also be unchecked, if you donõt need video analytic functions.  

 

[VI Server ]  (Optional)  

You can choose to install the  VI Server only on a standalone PC to manage the 

video intelligence data.  

j Insert the VMS/IPCAM product CD.  

Standalone Server (Client-Server All-in-One)

NVR Server

Local Client

VI Server

CMS Client

NVR

Server

VI Server CMS Domain Server

CMS Client

Multiple Servers + CMS Client

NVR

Server

NVR

Server

Standalone Server + Remote Web Client

Remote Client (or Web Client) NVR Server Remote Client (or Web Client)

request

response
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k Click VMS Suite on the menu to start the installation.  

l Choose Advanced Setup to choose VI Server only.  

 

 [SCC Domain Server ]  

Install the SCC Domain Server on a PC:  

j Insert the NVR/SMR product CD.  

k Click SCC Suite on the menu to start the installation.  

l Choose Advanced Setup to select the SCC Domain Server only. 

 

[SCC Client ]  

Install the SCC Client on PCs: 

j Insert the NVR/SMR product CD.  

k Click SCC Suite on the menu to start the installation.  

l Choose Advanced Setup to select the SCC Client only.  

 

Note:  (1) For users donõt have Surveon SMR/NVR series, please contact your dealer 

for the SCC installation file. (2) The SCC Domain Server can also be 

installed together with the SCC Client in the same PC by choosing Typical 

Setup. (3) Please refer to Installing the VMS and Installing the SCC for 

details.  
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3.3.4 . Network Requirements  

In order to preserve enough bandwidth for surveillance video, a surveillance 

network is presumed to be free of user/busi ness traffic. Server  software 

currently supports Class B and Class C type addresses. Currentl y the Server 

software only searches for Servers on the same subnet. Cameras should also 

reside on the same subnet.  

 

Opening Ports  

If access through a firewall in a local network  is required , try open ing the following 

ports: SMTP (25), HTTP (80), FTP (20, 21),  OMNI (2809), HTTPS (443) and RTSP (554, 

8554.) .  Other ports should also be opened while using port forwarding to access the 

VMS Server: Stream Port (9090), Doman Data Port (9060), Log Download Message 

Port (15507) and Log Download Data Port (9080). 

 

Access through a firewall  Use port forwarding to access  

SMTP (25), 

HTTP (80), 

FTP (20, 21),  

OMNI (2809), 

HTTPS (443), 

RTSP (554, 8554.)  

Stream Port (9090), 

Doman Data Port (9060), 

Log Download Message Port (15507), 

Log Download Data Port (9080) 

 

Note:  Please refer to  Port Forwarding  Section for more details.  

 

Warnings / Precautions  

If t he Server and a VMS client reside on separate subnets, please set up gateway, 

VLAN, or cross-subnet routing to bridge surveillance traffic. Please consult with a  

network administrator for problems with network set ups. A VMS client needs to 

be rebooted when network setting s are changed.  
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3.4. Port Forwarding  
Port forwarding is a name given to the combined technique of : 

1. Translating the address and/or port number of a packet to a new destination .  

2. Possibly accepting such packet(s) in a packet filter  (firewall) . 

3. Forwarding the packet according to the routing table.  

 

To illustrate its concept, two computers on the Internet that communicate with each 

other using TCP/IP or UDP/IP protocols (though the process is not limited to these ) 

utilize ports to identify the opposite connection points of each other where the data 

packets supposed to go to. In order to communicate, each computer knows the port of 

another computer (in addition to IP address) and sends the data to that port. Port  

forwarding forwards these ports in such a way that when one computer sends data to 

the specific port of another computer, the data is actually sent to a different po rt. 

This allows remote computers to connect to a specific computer or service within a 

private LAN. 

 

In a typical residential network, nodes obtain Internet access through a DSL or cable 

modem connected to a router  or network address translator  (NAT/NAPT). Hosts on the 

private network are connected to an Ethernet switch or communicate via a wireless 

LAN. The NAT device's external interface is configured with a public IP address. The 

computers behind the router, on the other hand, are invisible to hosts on the Internet 

as they each communicate only with a private IP address.  

 

When configuring port forwarding, the network administrator sets aside one port 

number on the gateway for the exclusive use of communicating with a service in the 

private network, located on a specific host. External hosts must know this port number 

and the address of the gateway to communicat e with the network -internal service.  

 

When used on gateway devices, a port forward may be implemented with a single rule 

to translate the destination address and port. The source address and port are, in this 

case, left unchanged. When used on machines that are not the default gateway of the 

network, the source address must be changed to be the address of the translating 

machine, or packets will bypass the translator and the connection will fail.  

http://en.wikipedia.org/wiki/Network_address_translator
http://en.wikipedia.org/wiki/Packet_filter
http://en.wikipedia.org/wiki/Routing
http://en.wikipedia.org/wiki/DSL_modem
http://en.wikipedia.org/wiki/Cable_modem
http://en.wikipedia.org/wiki/Cable_modem
http://en.wikipedia.org/wiki/Router_(computing)
http://en.wikipedia.org/wiki/Network_address_translator
http://en.wikipedia.org/wiki/Wireless_LAN
http://en.wikipedia.org/wiki/Wireless_LAN
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3.4.1. Port Forwarding for Accessing VMS Server  

To enable port forwarding for accessing VMS Server, please follow the steps below:  

1. Do Router Port Mapping for VMS/NVR Server 

Go to VMS Setup > Network  > Port Mapping  in VMS after it is installed.  

 

 

A Router Port Mapping  window will prompt for entering port numbers. Please put 

in the numbers as listed below:  

 

Stream Port : 9090 

Login: Port : 2809 

Doman Data Port : 9060 

Log Download Message Port: 15507 

Log Download Data Port: 9080 
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2. Open Ports on the Router 

Host Ports : The private ports that the internal VMS/NVR Server use, which are 

unchangeable. 

Global Ports : The public ports for remote clients to connect to the internal 

VMS/NVR Server. The Global ports are changeable, but the simplest way is to 

make them the same with the host ports.  

 

Please open the listed ports on your router:  

(When the option òEnable Automatic UPnP Mappingó is selected, this step can be 

skipped.) 

Port(Host/Global Port)  Protocol    Port Number  

Domain Message Port UDP 9050 

Domain Data Port  TCP 9060 

Login Port  TCP 2809 

Stream Port  TCP 9090 

Log Download Message Port TCP 15507 

Log Download Data Port  TCP 9080 
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Note:  Camera port (default: 80) and stream port (default: 6002) for accessing 

cameras should be opened while VMS/NVR Server and the cameras and are not 

in the same LAN. 
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Chapter 4. Installation  

4.1. Before You Start  

4.1.1. Checklist for Operating Environment  

Users need to prepare the following devices to set up the surveillance system. 

Network Video Recorder NVR3000 series 

IP Camera Network Cameras (such as CAM2441)  

Network Existing LAN, Switch, Router or Hub  
(please see the Network Topology below)  

Storage Hard Drives  

Note: The hard drives should be purchased separately.  

 

4.1.2. Checklist for  Network Topology  

Make sure you have the right switch/hub for your environment. Either of the 

following options will work.  

 Common Topology Reference Product  

Existing LAN LAN Switch with DHCP Server Office LAN 

Router LAN Switch with build -in DHCP Server D-Link DIR-130 

Switch/Hub  No DHCP Server(refer to the Note below)  D-Link DES-1108 

Note:  For devices without DHCP Server function, please refer to  Configuring DHCP 

Service Section. 
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4.2. Hard Drive Installation  

4.2.1. Hard Drive Installation Prerequisites  

Purchase hard drives having the same capacity and using same interface with the 

pre-installed ones.  

 

4.2.2. Inserting Hard Drive into Drive Bracket(s)  

1. Loosen the screws (total 8) on both sides and the rear part  of the device to 

remove the cover.  

 

 
 
 

2. Loosen the screws on the bracket(s) to remove the bracket(s).  
 

Note:  For the 4-Bay product, NVR3104 Series, there is only 1 HDD bracket.  

As for the 8-Bay product, NVR3308 Series, there are 2 layers of HDD brackets.  
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3. Install the HDDs onto the bracket(s) and secure them with screws supplied.  

For an easier cable connection, the HDD should be situated upside down  so that 

the connectors can be seen as indicated below.   

 

Be sure to install the HDDs according to the set order  as the indication shown.  

 

 

When the HDD installation is done, put the bracket(s ) back and fasten with screws 

supplied.    

 

For NVR3308 series, it would be easier to connect the cables of the lower deck of 

HDDs first, before putting the upper deck of HDDs back.  

 

 



 

 46 

4. Connect the cables to the right HDDs.  

SATA Cable Connection 

You can find the number indications on each SATA cable and the wiring 

description sticker on the back  of the cover. Be sure to connect the HDDs and the 

cables by the same number they are bearing,  e.g. HDD1 to Cable 1 and vice versa. 

 

Power Cable Connection 

After the SATA connection is done, be sure to connect the power cable for each 

HDD before putting the  cover back. Loosen the cable tie for easier power 

connections and tighten the cable tie to arrange  the power cables, once the 

connection is done.  

 

Note:  The order of the connected HDDs and cables will affect the operation.  

 

For NVR3104 Series, the wiring connection to the HDDs will be as indicated below.  
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For NVR3308 series, the wiring connection to the HDDs will be as indicated below.  

 

 

 

5. Check if the connections are properly done with no wiring problems and then 

put the cover back and secure it with screws.  
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4.3. System Connections  

 

 

Â Insert mouse, keyboard or other external devices to the USB port for 

operating  the Video Management Software (VMS). 

Â Insert the LAN cable to the upper LAN port to connect the NVR3000 Series 

to a local network where your IP cameras reside.  

 (Connection to analog cameras is also available via an IP encoder.) 

Â Connect an external monitor capable of 32bit or higher color qual ity to the 

VGA Port to view the VMS interface .  

 



  

  49 

4.4. Powering up NVR3000 Series 

4.4.1. NVR3000  Desktop Systems 

1. Attach the power cable to the power socket on the rear panel.  

2. Press the power switch for power supply.  

 

 

 

 

 

 

 

 

 

 

Note:  Before powering up, make sure all the USB external HDDs are disconnected 

from the NVR3000 series. Otherwise, the system may have to run the contents 

of the connected USB and errors may occur.  

 

3. Press the power button to turn on the device.  
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4.5. Logging into NVR3000 Series  
The Local Client will prompt for the following information after the NVR3000 Series 

system is powered on: 

 

· Username:  The username of the domain, which is always admin.  

· Password: The password of the domain. Default password is admin.  

· Auto Login:  Check this option and you do not have to input the username and 

the password again when logging in next time.  

Click Login after the password is entered.  
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4.6.  Run the Install Wizard  
When you run the NVR series for the first time, you need to go through the 

following steps within the Install Wizard after logging in.  

 

1. Welcome: Use the dropdown list to select the language for the VMS. Click  òNextó 

to go to the next step Confirm the number of your hard drives.  

 

 

2. Confirm the number of your hard drives : the system will auto detect the 

number of installed hard drives.  

 

Check if the detection result is correct, if yes, click òYes and proceedó or 

òNextó to go to the next step Recording plan . 

 

If the detection result is not as expected, click òNo and shutdownó. Shutdown 

the system and make sure all the drives are installed properly. After checking, 

restart the system to run the install wizard.  

 

Contact your system administrator, if this error keeps happening.  
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3. Recording plan : Select the best storage configuration for the system. See the 

following table for reference.  

RAID Level  

RAID Description  
Min.  

HDD 

HDD Used 

for Storage  

Non-

RAID 

No protection, but 

maximum capacity.  
2  All of HDDs  

RAID 1 
Best protection. Your data 

will be mirrored.  
2  Half of HDDs  

RAID 5 

Use 1 disk to store the 

parity function data to 

provide fault tolerance.  

3 
 HDD number  

 minus 1 

RAID 6 

Used 2 disks to store the 

parity function data to 

provide fault tolerance.  

4 
 HDD number  

 minus 2  

 

Please seek for professional help, if you are not sure how to select the RAID level.  
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Note:  When setup RAID for JBOD connections, please make sure to stop NVR 

recording firstly before configuration.  

 

(3-1) Default recording behavior : Select the best recording method. When Always 

recording  is selected, every image will be recorded. When Motion recording  is 

selected, only motion detected images will be recorded, and approximately 

25~60% storage can be saved according to the levels of motion detection 

sensitivities you have set.  
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Click òNextó to go to the next step Time . 

 

4. Time : Time setup should be done correctly; otherwise some of the functions will 

be affected. Set up the time zone before setting up the time.  

 

Note:  Date/Time should be set correctly before recording.  

 

(4-1) Time synchronization : There are options to choose from.  

 ̧ Time synchronization can be applied to all connected cameras.  

 ̧ You can also make this NVR as time server so that the time synchronization 
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can be applied to all the connected devices.  

 ̧ You can have the time on the system to be synchronized with the NTP time 

server. 

 

 

Click òNextó to go to the next step Basic settings . 

 

5. Basic Settings: You can change or use the default password. Check the òUse 

Default Passwordó option, if you wish to keep the default password.   

If you want to change the password, input a new password and confirm the 

newly created password.   

 

Note:  The system will restart when the server name is changed.  
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Click òNextó to go to the next step Network .  

 

6. Network:   Different network settings can be applied to 2 LANs if there are 2 LANs 

on the system. It is recommended to select òAuto detect ó, since the system will 

detect if there is any DHCP server available. If yes, it will assign an IP address.  

 

You also can select òUse fixed IPó to input the IP address of this NVR and make 

this NVR as a DHCP server. After selecting, input the relevant information and 

check òEnable DHCP service on this  NVRó to confirm the setting. 

 

 

 

Warning:  Make sure that only 1 DHCP server is activated in your system, 

otherwise it may cause network errors.  

 

Note:  You can also change the network settings, once youõre logged in to the 

Local Client. Go to Setup > Network > DHCP Server for the network configura tion.  

 

Click òNextó to go to the next step Summary. 

 

7. Summary:  This page shows the setting results you have set so far. Check if the 

results are what you wished for. If not, click on the items to go back the items 

you wish to modify and set up again.  
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After clicking òNextó, the wizard will start to initialize your system and go to the 

next step Progressing. 

 

If you wish to set up the local display, you can click this item and go to the Local 

display page.  

 

Local display : Select the best method for your  scenario to have a balanced 

resource usage for the quality of recording and local display.  
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Note:  The system will restart when the setting is changed.  

 

8. Progressing: After clicking òNextó on the summary page, the wizard will start to 

initialize your syste m. This act will take a few minutes to complete. Once it is 

done, the system will reboot automatically.  

 

 

9. All complete: All the necessary settings are done. Click òFinishó to close this 
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window and the system will be directed to the VMS. You can modify and  configure 

more settings later in the setup page.  

 

 

(9-1) Camera detection : The system will detect the cameras in the same LAN.  

Click the detection result to go to the next step Add camera . 

Click òFinishó to close this window. You can add cameras later in the setup 

page. 

 

 
10. Add camera : The detected cameras will be shown here. Select the cameras you 

wish to add and click òAdd selectedó to add the selected cameras. 
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Click òRescanó to detect the cameras again. 

Click òFinishó to close this window. You can also add cameras later in the 

setup page. 

 
 

After the wizard installation is done, you will see the  Live View  page from the 

Local Client .   
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Chapter 5. Basic System Settings  

5.1. Storage Management  
1. To access the information about the drives configured in your Server, click Setup 

 to bring out VMS Setup window and then select Record to see and click 

Storage option for Storage Manager. 

 

 

2. All available Logical Drives, as well as their sizes, free spac e, and status will 

appear. Click target drive and then Setting  to set the log and location for saving 

the video recordings.  
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3. Click the target drive first and then Settings.  In òGeneraló tab, click Check. 

 

 

4. Choose the RAID level, and then click Create L ogical Drive  to create the RAID 

configuration. The system supports recording to ISCSI and NAS. 

 

5. In òIP Storageó tab, you can authenticate targets by clicking CHAP to setup CHAP.  
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Â Add: Click Add and input the required information to add more targets.   

 

Â Delete: Click Delete  to delete the selected.  

Â Refresh: Click Refresh to refresh.  

Â Target: Click Targets to see the setup result.  

 

6. In òNASó tab, you can add NAS in as the video storage.  

  

 

Click Add and input the required information to add NAS as the video storage.  
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5.2.  Adding Cameras to the Server  
Cameras can be added to the Server in two ways: via an automatic scan or by 

manually inputting the camera information.  

 

5.2.1. Automatic Scan for Ca meras 

Right-click on the òDefault Groupó area to bring out the setting menu  and select 

Scan For Camera. 

 

 

1. The system will respond by beginning an automatic scan. Once the scan is 

complete, the cameras that can be added to the Server will be displayed. 

Information available for each camera will include:  
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Â Name ð The default camera name (Make/Model)  

Â Status ð The camera will display New if it has not been added to this 

Server, otherwise it will display Assigned. 

Â IP Address 

Â MAC Address 

Â Vendor - Including ACTI, Afreey, AXIS, Arecont, BOSCH, Dahua, 

Dynacolor, EDIMAX, EverFocus, HIKVISION, IQinvision, JVC, LG, 

Panasonic, and Surveon. 

Â Model 

 

2. To add a camera to the system, check the box by the camera entry. You may 

also check the Select All  box at the bottom of the window to select all the 

cameras found. Enter the username and password, and press Apply Selected . 

Click OK to add the selected cameras to the Server.  

 

 

The following windows will prompt for validation.  
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5.2.2. Manually Adding Cameras 

1. Right-click on the òDefault Groupó area to bring out the setting menu  and 

select Add Camera to manually add a camera to the Server.  

 

 

2. In the camera window, fill out the following information:   

 

Â IP Address 

Â Camera Port ð This value will automatically populate with the default 

value for the Vendor  and Model selected.  
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Â Vendor - Including Including ACTI, Afreey, AXIS, Arecont, BOSCH, 

Dahua, Dynacolor, EDIMAX, EverFocus, HIKVISION, IQinvision, JVC, 

LG, Panasonic, and Surveon. 

Â Stream Port ð This value will automatically populate with the default 

value for the Vendor  and Model selected.  

Â User Name ð This value is not always required.  

Â Password ð This value is not always required.  

Â Camera Name ð It is recommended you change t his value if you have 

more than one camera of this make/model.  

Â Camera Icon ð Select or change icon here.  

Â Camera Description ð Add more information here.  
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5.3. Setting Recording Schedule  

5.3.1. Recording Schedule  

Click   to bring out VMS Setup window and select Record and then Schedule.  

 

 

 

1. The schedule grid corresponds to every hour in the week. Click on one of the 

4 recording methods and then click on the grid area to òpaint inó the method 

for the corresponding hour.  
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2. Click the Apply button to apply the schedule and OK to exit the dialog.  
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5.4. Setting up Live View  
An important part of monitoring your surveillance network is to have the right 

views so that you will have the optimum viewing angle to discern a situation.  

The default view setting is 4x4.  

 

From the Camera List, you can click and drag each camera into separate frames. 

The camera output will be displayed in the frame.  

 

 

On the Main View Area, right click on one camera view. Select Others >> 

Remove Camera to delete this camera view on the main frame.  
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Chapter 6. Live View  

Live viewing is a crucial part of any surveillance system. Having the right view 

can be the crucial difference between catching an event as it happens and 

missing it altogether. VMS provides powerful tools to manage the viewing 

experience to help ensure that monitoring personnel are always on top of any 

event.  

 

6.1. Live View Window Overview  
The live view window is split into 10 distinct parts:  

 

1. Live View / Playback Selection Tabs ð Allows users to choose live view and 

playback mode. 

2. Camera List ð Lists all the connected cameras.  

3. Snapshot ð Take a snapshot of the current camera image.  

4. Volume Control ð Control the volume.  

5. Microphone ð Enable/Disable the microphone functionality.  

6. Live View Control ð PTZ functions, including Preset, Auto Pan, and Patrol for 

PTZ-enabled cameras. 
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7. System Health Diagnosis ð Displays RAID problems, disk failure, service 

problems, fan/power failures.  

8. Log - This area contains all the logs, system, video, s torage, network status 

information.  

9. Details ð List all the detailed logs for review, query and export.  

10. Alarm ð When triggered, the icon will flick with a red colored alarm 

.  

11. System status - This area contains system, network, camera  and recording 

status information.  

12. Button Area  - This area contains the buttons to change views, enter the full 

screen mode, go to the next/previous page, go home and auto page flip 

between pages.  

 

Full screen mode 

 

Viewing screen modes 

 

Auto page flip between pages  

 

When there are more than 1 live 

view page, click these buttons 

to go to the next / previous 

page. 

 

Select this icon to have better 

views for fisheye camera  

 

E-map 

 

Send to the Secondary Display 

 

PAP View 

 

 
Select according to the way 
your fisheye is installed to have 
a best viewing result, Ceiling 
Mount, Table/Floor Mount or 
Wall Mount.  

 

 

The distorted hemispherical 

image of the fisheye camera can 
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be converted into a 

conventional rectilinear 

projection , a split -window

, a 4 split -window  

with 3 enlarge windows and 1 

original image window,  an 

enlarged window and the 

original fisheye view .  

 

Date and time  

 

Signed in User Account 

 

Logout  

 

About contains version and 

product information  

 

Enclosed with the user manual  

 

Setup button  

 

Shutdown button  

13. Main View Area  ð This area contains the actual video feed(s).  
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6.2. View Setup  

6.2.1. Switching Between Different Screen Divisions  

Creating and Using New Screen Divisions  

When a view is created, it has a default screen division setting, however when 

using the view, it may be useful to change the number of screen divisions. This 

does not create a different view, but divides the existing view into a new set of 

divisions. 

 

 

To perform this function within the view, simply click the button corresponding 

to the view that you want to use. The buttons are located in the area above the 

main view window.  

 

After you have clicked on the desired view, the cameras will be divided into 

separate pages in the selected view; the formula is 36/selected view number. For 

example, a one view will have a 36 pages of views and a 1+5 view will be 36/6, 6 

pages of views.  

 

Auto -flipping Pages  

When multiple pages of screen divisions exist, you may choose to automat ically 

flip between the pages by clicking on the  button. Clicking the button again 

will end the automatic flip function.  

 

  

Screen Division Page Use 

The page number is displayed to the right of the view buttons. Clicking on the 

arrow button to the right  of the page number or clicking on the current screen 

partition button will scroll through the pages in order. Clicking on the arrow 

button to the left of the page number will scroll through the pages in reverse 

order.  
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Fisheye View  

Click the Fisheye butt on  in the button area when using a fisheye camera. 

This will bring out a selection of views for fisheye camera to have better view 

results.  

 

 

 

Select according to the way your fisheye is installed to have a best viewing result, 

Ceiling Mount, Table/Floor Mount or Wall Mount.   

Icon Description  Reference  

 

conventional rectilinear 

projection, panorama 

view 

 

 

split -window, horizontal 

view 
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4 split -windows: 3 

enlarged view windows 

and 1 original fisheye 

window.  

Place the different 

colored boxes in the 

original fisheye window 

on the upper right corner 

to have detailed views 

projected on the other 

viewing windows.  

 

 

1 enlarged view window 

and 1 an original fisheye 

window.  

Place the colored box in 

the original fisheye 

window on the upper r ight 

corner to have a detailed 

view projected.  
 

 

original fisheye view  
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Fisheye Tracking  

Select one camera and click the Fisheye button in the top tab when using a 

fisheye mode. Click the top right corner  symbol.   

 

 

The fisheye tracking mode will be displayed in the bottom of Main View section, 

providing automatically rotating view.  
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E-map 

Click the E-map button   in the button area to open an existing E -map or create 

an E-map.  

 

 

When there is an existing E-map, the E-map will be shown as below. You can click 

the set camera on the map to see its surroundings.  If there is an alarm, the set 

camera on the E-map will begin flicking and you can have a better idea where the 

event took p lace.  

 

 

When there is no E-map stored, the system will ask you to add an E -map.  Follow 

the steps below to create an E -map. 

1. Prepare layout drawings or a map of the area being surveyed.  

2. Click the Add button to bring out the Add Map window.  
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3. Click the Browse button to open a windows dialog. Select your map and click 

the Open button. The drawing will be stored in the Server.  

4. Enter a name for the map in the Map Name field.  

5. Click Save. Once successfully added, an E-map node will appear.  

6. Go to the Camera List tab to drag and drop the cameras to the desired 

location on the E -map to complete the E -map creation.  
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For camera relocation, click  to select the cameras and then the 

selected camera can be moved.  

 

Go to VMS Setup > System > Map Editor  in the setup to add another E-map 

or any further setups.  

 

Secondary Display  

Click the Secondary Display button  in the button area when you have the 

second monitor, the view will be sent to the secondary display.  
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6.3. Functionality within Views  
Right clicking an active window will cause a function list to appear. These are 

settings and functions that can be changed within the live -view window.  

 

 

6.3.1. Object Tracking  

Object tracking can be used to track object. Only one channel could be added to 

do the object tracking. Select one channel. Right -click the panel and select 

Object Tracking  to activate the function. The selected framed and tracking 

object will display surrounded in blue square.  
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6.3.2. Digital Zoom  

Digital zoom increases the view size without increasing resolution. The digital 

zoom function can be used within any panel (even in full screen mode) with the 

following steps:  

1. Right-click the panel that zoom is required on, and select Digital Zoom  to 

acti vate the function. A picture -in-picture showing the whole screen framed 

by a yellow box will appear.  

2. Use the mouse scroll to zoom into the center of the image. Scrolling forward 

will zoom in, scrolling backward will zoom out.  Click the corners of the box 

and drag to the area of interest. The main picture will show the digitally -

zoomed output, while the picture and picture will display the entire view.  
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6.3.3. Instant Playback  

The instant playback function gives users the ability to instantly playback up t o 

45 minutes of video, from 20 sec to 45 min. Right -click the video panel that 

playback is required on, and select Instant Play > [Time Length] to activate the 

function. A popup will open with the desired playback. Time lengths available are 

dependent on, and will not exceed the pre -alarm recording time set in Pre/Post 

Recording.  
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The following table explains the buttons:  

 

Snapshot 

 

Audio volume 

 

Time range can be set when viewing the 

playback.  

 

Full frame mode  

 

Key frame mode 

 

Saves video clips/Exports selected clips  

 

Clear all the Cue-Ins and Cue-Outs 

 

Set Cue-In marker for clip start  

 

Set Cue-out marker for clip end  

 

Automatic reply the clip.  

(From Cue-in to Cue-Out) 

 

Play backwards 

 

Starts video playback 
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Pause video playback 

 

Stops video playback. 

 

Jumps to the previous frame  

 

Jumps to the next frame  

 

Jumps to the previous segment 

 

Jumps to the next segment  

 

The play speed can be adjusted from 1x to 8x.  

 

6.3.4. Manual Recording  

When recording schedules are set, it may be necessary to manually record a 

video stream, even when the schedule does not specify for recording. I n this case 

right -click the panel that recording is required on, and select Manual Record > [5, 

10 or 30 minutes]  to activate the function. The camera will record the stream 

for the amount of time specified.  

 

 

  

file:///D:/Surveon/NVR7300(EV5000)/FINAL%20v1.1/NVR7300_Series_PMN_v1.1%20copy.docx%23scheduling
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6.3.5. Others  

Image Settings 

Camera image settings can also be accessed by right-clicking the panel containing 

the camera video and selecting  Others > Image Settings .  

 

 

 

 

1. Adjust the following sliders to change the camera image:  

Â Brightness  ð The overall lighting level of the image. This value ca n be 

used to boost or reduce the apparent lighting of the image.  

Â Saturation  ð The overall color intensity of the image. This value can be 

used to boost or reduce overall color intensity.  

Â Contrast ð The lighting difference between dark and light areas of th e 

image. This value can be used to boost or reduce apparent differences 

in lighting.  
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Â Hue ð The color cast of the image. This value can be used to 

compensate for colored lighting or other color casting.  

Â Sharpness ð The edge contrast of the image. This value  can be used to 

make the picture appear clearer.  

2. Click OK to save your changes. 

3. Click Copy Settings to have the same settings applied to other cameras.  

Once Copy Settings button is clicked, the following window will appear. Select 

the cameras youõd like to have the same settings applied to save time.  

 

Note:  Camera Image Settings can also be configured by right -click the camera entry 

in the Camera List below the Live View , then click Image > Image.  
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Insert Image  

The panel can be replaced with a user overlay.  

 

To overlay an image on top of a panel:  

1. Right-click the panel and choose  Others > Insert > Image. The system will 

prompt you to choose an image file.  

2. Choose an image file, valid image types are JPEG, BMP, TIF and PNG. Click 

Open to open the file.  

3. The image will be displayed in the panel. Click the red X in the top -right corner 

to close the image.  

 

Insert HTML 

The HTML overlay function allows simple integration of web applications in the 

VMS by replacing one or more panels of the screen with an active browsing 

window. To overlay an HTML form or website on top of a panel:  

1. Right-click the panel and choose  Others > Insert > HTML . 

 

2. In the field, enter a URL or the p ath containing the HTML form. You may also 

choose to click Browse and choose an HTML file.  

3. The HTML or website will be displayed in the panel. Click the red X in the top -

right corner to close the image.  
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Send to Large Channel  

  

When the view with diff erent sizes is selected, views in smaller divisions can be 

switched to the larger division. To perform this action, right -click the panel 

corresponding to the camera and choose Others > Send to Large Channel.  

 

Reconnect  

 

In some cases it may be necessary to manually reset the connection to a camera. 

To perform this action, right -click the panel corresponding to the camera and 

choose Others > Reconnect.  
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Remove the Camera  

The Cameras can be removed by clicking Others >  Remove Camera. 

 

 

Keep Video Length -Width Ratio / Resize to Fit Window  

The image can be set as the length-width ratio or resize to fit window by clicking  

Others >  Keep Video Length -Width Ratio / Resize to Fit Window . 

 

Object Counting (can only be set via remote client)  

Object Counting result can be displayed (if it has been set) by clicking Others >  

Object Counting .  
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6.4. Full Screen View  

6.4.1. Entering Full Screen View  

From any view, you can switch to full screen mode by clicking on the full screen 

button   located above the main viewing window. Optionally you may also 

choose to view a single frame in full screen mode by double clicking on the frame.  

 

 

6.4.2. Exiting Full Screen Mode  

To exit full screen mode, hit the ESC key on your keyboard.  
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Chapter 7.  Server Setup  

This section deals with Server setup procedures.  

 

7.1. Server Settings  

7.1.1. General Server Settings  

The following sections deal with Server settings that can be configured under the 

Server Settings menu.  

 

1. Click  to bring out VMS Setup window and select System and then select 

General Server Settings. 

 

 

2. A tabbed window will appear providing the following configuration tabs: 

Storage Quota and Time Settings.   
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Â Storage Quota  

 

In the Minimum Free Space field, the Minimum space required for storage is 

shown. The storage will be last for 30 days. Click on the items in the Position 

section and use the Up and Down buttons to change the storage priorities.  

 

Â Time Setup  

 

To set the server time c lick on the number you wish to change and enter a 

value.  Click OK to preserve the setting. The default  time is set according to 

the real -time clock on server.   

 

Â Time Synchronize  


















































































































































































































































































































































































































































































































